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I am so excited about the redesign of our publication. It is an
absolute pleasure and honour to design for this magazine. It is such
a creative process, which I enjoy immensely, especially working with
such incredibly talented artists, photographers, illustrators and
designers. It is the sweet spot of creativity.

If you haven't already, be sure to check out our Teaser Trailer for
Issue #6 on http://youtube.com/steveczajka. It was so much fun to
repurpose the content of our magazine into video, and this is
another benefit of our next generation magazine. Also be sure to
check out our Directors Cut & Commentary for Issue #6. I plan to
incorporate more video (both creative & instructional) with our
magazine.

Issue #6 was all about amazing photography from Aaron Tyree
and Issue #7 is all about amazing illustration from Evelyne Schulz. It
is truly a privilege for me to be a part of this magazine considering
the caliber of photographers and illustrators who submit their works
and trust us with the design, layout and presentation of their art.
This issue is a special treat as we have Evelyne Schulz who is an
amazing illustrator who uses GIMP software. I love the simplicity of
her tutorial, and the incredibly inspiring interview article. A special
thanks is due to Debi Dalio for developing and editing the amazing
article and the master class. This is such an inspiring issue.

Looking forward to Issue #8 we have Ian Muttoo on deck for Night
and Low Light Photography. We are in need of submissions for our
gallery and new stories for Issue #10. GIMP Magazine is a wonderful
way of featuring your art and story to the world. If you have video-
based tutorials, we can incorporate them too. You would be sharing
your art with roughly 15 thousand followers, and millions of views on
Google+ and our website. We have honestly lost count of our
magazine downloads because our magazine is everywhere via bit
torrent and other amazing sites. On http://issuu.com/gimpmagazine

we have had over a million impressions alone. And this is great news
for GIMP enthusiasts worldwide.

If you are a reader of GIMP Magazine we would greatly appreciate
it if you could help to continue GIMP Magazine by supporting it at
Patreon. Your PayPal or credit card support via Patreon will help us
to keep this magazine going by paying for our website, cloud storage,
and subscription fees. We have set a goal to help us to pay
members of our team who all contribute for free, and our submitters
who also currently submit their art for free. If we reach our goal we
will be able to pay people on our team and to those who submit
content. Check out the details on
http://patreon.com/gimpmagazine.

The team at GIMP Magazine is thrilled to present Issue #7. If you
are not already doing so, please follow us on Twitter, Google+, Issue,
or by email subscription. Also, tell a friend about GIMP and GIMP
Magazine and kindly tweet or blog about us to help spread the word.

Enjoy!

Cheers
Steve
http://twitter.com/steveczajka
http://flickr.com/steveczajka

LETTER FROM THE ED I TOR
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PAINTING WITH GIMP

Master Class Tutorial by Evelyne Schulz, edited by Debi Dalio
GIMP is quite adept at allowing an artist to draw and paint digitally. In this tutorial, I explain my
general method for creating a digital painting.
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STEP 1 – SKETCHING THE INITIAL IMAGE

I often sketch my very first ideas on paper, whenever I have time – in the morning, on my lunch break, in
bed before going to sleep. When I first began creating digital art I used to take a photo of my best sketch
and use it as a base. When I draw a base today I use a Wacom Cintiq graphics tablet and the Paintbrush
tool with different colors and usually the “Pen Generic” Dynamics setting with about 80 per cent opacity.
You can save specific brush settings, name them, and recall them using the “Save Tool Preset” and “Restore
Tool Preset” icons at the bottom of the Tool Options dialog.
Personally I don’t sketch too many details, since I prefer colors instead of lines. I change a lot while
coloring, and add details and new elements as I go.
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STEP 2 – SELECTING THE COLORS

Next I add rough colors. I try out the lighting and choose colors for the different elements. You can put a
dot of every color you're using in a corner of the picture and use this as a sample palette from which you
can pick up a color. To quickly pick up a specific color, press O to select the Color Picker tool, then click on
the color you want.
Alternatively, you can create your own color palette in the Palette window. Choose Windows > Dockable
Dialogs > Palettes to open this window. Create a new palette by clicking on the blank paper icon at the
bottom of the window or by clicking on the left-arrow at the top right of the window and selecting Palettes
Menu > New Palette. This will open the Palette Editor.

A unique name for the palette can be entered in the text box at the top. The current foreground or
background color can be added to the palette either by clicking on the blank paper icon at the bottom of
the Palette Editor or by clicking on the left-arrow at the top right of the Palette Editor and selecting Palette
Editor Menu > New Color from FG (or BG). You can add, change, and delete colors as necessary, and adjust
the Columns number to affect how the colors are displayed in the Palette Editor. While you're drawing,
simply left-click on a color in the Palette Editor to set the foreground color to that color.
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STEP 3 – WORKING WITH LAYERS

At this point in the process I’m working on about ten layers, but this number will increase later. If you use
many layers, it’s very important that you name them correctly. One great feature of GIMP is the layer
groups. Later on I will have reached fifty or more layers, so I group them and create a logically named
structure. This saves a lot of time, because you never have to go searching for a particular layer.
For this picture I’m working with a resolution of 5100 x 6700 pixels, so a large number of layers can result
in performance problems. To avoid that, as soon as you have finalized a part and don’t need separate
layers any more, merge them into one layer. Another great thing is that GIMP can handle layers of all sizes;
that is, all layers do not need to be the same size. Use the Crop tool to crop a layer to the needed size to
save lots of memory. Remember to tick the “Current layer only” setting for the Crop tool, or use Layer >
Crop to Selection.
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STEP 4 – REFINING THE IMAGE

I tend to smudge more than I paint. I put some color on the picture and smudge it into place. If the current
layer gets too transparent from smudging, I duplicate it, several times if necessary, then merge the layers.
The Smudge tool has a great advantage. It makes mixing colors easy. By using a soft brush and a low “Rate”
setting, you can create very smooth gradients and add fine shades of color. Structure and edges can be
added by using a hard brush or by ticking the “Hard edge” option.
I refine the picture until I have a clean, plain base image. In the example picture, I have already added
some lighting and shading, but I will keep adjusting this while working out the details. For adding highlights
and shadows I use the Paintbrush tool and the “Lighten only” or “Darken only” mode, usually with a very
low opacity. Working in this way, I can add small amounts of color, and lighten some parts while making
other parts darker.
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STEP 5 – ADDING TEXTURES

Now that I have a refined, plain base image and have settled on the final colors, everything looks pretty
nice, but far too smooth and lifeless. Have a look around. Have a look at yourself. How many surfaces are
plain and smooth? Not too many.
So now I start adding textures. In this picture I have already done this on the helmet. I created a separate
layer, selected an area of the helmet with the Free Select tool, ticked “Feather edges”, and filled the area
with a pattern. This is not a pattern fill though – that would look far too static. I applied the pattern using a
brush called “Texture Hose 02” with about 60 per cent opacity and with the “Apply Jitter” option checked,
which lets you spread the texture randomly over the selected area.
I erased some parts of the texture to create a more interesting look, and added more of the same texture
on the rest of the armor. To make the armor look less clean, I added another layer with a softer structure
and lowered the opacity to about 15 %. This is enough to make the armor look more like real metal.
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STEP 6 – ADDING SPECIAL ELEMENTS

I then continue to add textures on the leather and fabric pieces, trying out different brushes and playing
with the opacity settings. (Remember, you can create your own brushes or download some – even
Photoshop brushes.) The textures don’t have to be applied in black by the way. Sometimes a different color
looks much better.

I used the elements shown in the upper left corner of
the picture as customized “brushes”.
To create an element, I draw it on a new layer. In most
cases I also add a slight shadow below the element.
This allows me to place it wherever I want without
having to add the shading afterward. When the
element is finished, I select it and copy it, and it
appears in the Brush selection list of the drawing tools
and has the name “Clipboard”. Now it's possible to use
the element as a “stamp”. You can change the size, you
can rotate it, you can even stretch it in any direction
you want – just have a look at the options in the Tool
Options dialogue.
It’s not hard to see where I placed the buttons and the
stitches. I put them on new layers and adjusted the
color and brightness afterward so they would blend in
with the rest of the picture.
The hair is made of a black base and many
transformed versions of one piece of hair. Some are thinner, some are flipped, some are rotated, and in
the top part of the head they are bent into shape using a cage transformation.
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STEP 7 – ADDING THE BACKGROUND

Finally, I add the background. For painting clouds I add colors with a standard brush and smudge the
colors using texture brushes such as the ones called “Smoke” and “Texture 1”. As a last step I adjust the
colors, the brightness, and the contrast.

ABOUT EVELYNE SCHULZ

Evelyne Schulz grew up in a creative family and went to art school briefly before deciding to concentrate on
a more technical career. She became a media expert, did layout, and worked as a web designer and
software engineer. Currently she is employed as a key account manager for a company that publishes
books and a wide range of printed matter. She also works as an artist creating illustrations and concept art
according to customer desires and requirements. She made the switch to digital art recently, and, after
trying out different programs, returned to GIMP, the program she has been using since she got her very
first computer when she was about 12 years old.
Evelyne can be found at the following places:
Website: http://www.eleathyra.com/
deviantART: http://eleathyra.deviantart.com/
Tumblr: http://eleathyra.tumblr.com/
Twitter: https://twitter.com/Eleathyra (@Eleathyra) ■
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WANT MORE TIPS & TRICKS?SUBSCRIBE TO OURYOUTUBE CHANNEL

HTTP://YOUTUBE.COM/STEVECZAJKA



WANT TO BECOME THE EDITOR FOR GIMP MAGAZINE?
ARE YOU INTERESTED IN PHOTOGRAPHY OR DIGITAL ART?WE HAVE A HUGE OPPORTUNITY FOR YOU:•DISCOVER AND WORK WITH SOME OUTSTANDING GIMPPHOTOGRAPHERS, ILLUSTRATORS AND DESIGNERS FROM ALLOVER THE WORLD•PUT YOUR STAMP ON EACH MAGAZINE•BUILD & DESIGN MAGAZINE SPREADS
AND PROMOTE YOUR WORKS TO MILLIONS OF ENGAGEDREADERS WORLD WIDE.

EMAIL US AT HTTP://GIMPMAGAZINE.ORG/CONTACT



GIMP MAGAZINE BY THE NUMBERS



FOLLOW DAVE LEPEK ON TWITTER @ACCORDING2DAVE

WE LOVE PIE AT GIMP MAGAZINE, SO MUCH SO THAT WE AREDEDICATING AN ENTIRE ISSUE (SPRING 2015) TO PIE. WE AREASKING EVERYONE TO SUBMIT THEIR FAVORITE PIE PHOTOS(MACRO, FOCUS BLUR, ANY PHOTOGRAPHIC TECHNIQUE YOU LIKE),PIE GRAPHIC DESIGNS, AND EVEN PIE STORIES OF WHY YOU LOVEPIE.
GIMPMAGAZINE.ORG/SUBMISSIONS



Meet The GIMP!
A Videopodcast

about
Free and Open Source Graphics

Software

http://meetthegimp.org

http://meetthegimp.org


FOLLOW DEBI DALIO ATHTTP://PORTRAITS-NATURALLY.BLOGSPOT.COM/"MASK OF THE COCKATOO"
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DEBI DALIO

Title: Fountain of Feathers
Description: This image was created from a
photograph I took. I used the following
tools and techniques in GIMP: Curves,
Gaussian Blur for sharpening, masks, Free
Select, Paintbrush, copy and paste, Blend,
and saturation adjustments. You can read
the full tutorial at http://portraits-
naturally.blogspot.com/2014/10/creating-
fountain-of-feathers.html.
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JADE QUINTON-JACQ

Title: Daughter of the Dragon
Description: I am French and a self-taught digital artist and
freelance illustrator. I have been using GIMP for almost seven years.
It suits me perfectly for my creations, whether paintings, drawings,
or comics. This digital painting was done entirely with GIMP 2.8.
Blog: http://hiboureveur.blogspot.fr/
Portfolio: http://arc-ange.deviantart.com/

STEVE CZAJKA

Title: Uncial Calligraphy
Description: This is a custom design type. Uncial was authentically
created by hand using a Pilot Parallel Calligraphy Pen on special
paper. The type was scanned and posted processed using GIMP.
The composition you see was designed using Inkscape. The white
letters were vectorized and turned white. The red letters were
colourized in Inkscape. I plan to make this designer type
commercially available.
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ALDRIN ROCKY SAMPELILING

Title: AdSEAN (Advertising ASEAN)
Description: This is a poster I made to promote our event AdSEAN
(Advertising ASEAN), an advertising video competition for ASEAN Youth. I
made this using GIMP 2.8. All of the contents (except for some logos,
the photo, the flag, and downloaded pattern and fonts) were made with
GIMP 2.8.
I used the Paintbrush tool to make the film strip and then I added video
3x3 without additive filter to make it cooler. I also used the Rectangle
Select tool, Ellipse Select tool, Free Select tool, Gfig filter (Filters >
Render > Gfig), Video filter (Filters > Distorts > Video), and Mosaic filter
(Filters > Distorts > Mosiac) to make the rest of it.
Website: aldrinrocky.weebly.com
Twitter: https://twitter.com/AldrinRocky (@AldrinRocky)

STEVE CZAJKA

Title: Personalized Greeting Cards
Description: I created about 60 personalized 5"x7" greeting cards.
Each card had a persons (or family's) name done in authentic
calligraphy draped on top of seasonal stock photography /
textures. The inside of the cards have greetings also done in
authentic calligraphy. All of the lettering was completed with my
new designer type that I plan to offer commercially.
This project workflow consisted of starting in GIMP for processing
the background images and all lettering, then Inkscape for the
layout of each card (outsides & insides), and finally Scribus for the
production of a single 120 page PDF file that was sent to the print
shop. This was a fun project that anyone can do using completely
FREE software.
Webite: http://flickr.com/steveczajka
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WYATT NOLEN

Title: Glyph
Description: I used Gimp 2.6 to create the image, and the female
used is actually one of my own stock images. The blue effect comes
from first drawing the shape, filling it in with black or white and then
changing the layer blend to ‘Color’. Duplicate that ‘Color’ layer and
set it to ‘Overlay’. You can now colorize this layer and get a variety of
cool effects. I’d recommend doing a displace and bump map to give
it a little more texture!
Portfolio: http://internetknight.deviantart.com/

DID YOU KNOW?
IN 1998, SERGEY BRIN CREATED A COMPUTERIZEDVERSION OF THE GOOGLE LETTERS USING THE FREEGRAPHICS PROGRAM GIMP. (SOURCE,HTTP://EN.WIKIPEDIA.ORG/WIKI/GOOGLE_LOGO)



http://gimpmagazine.org/courses/


http://gimpmagazine.org/courses/


http://gimpmagazine.org/courses/
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AN INTERVIEW WITH EVELYNE
SCHULZ

by Debi Dalio
Evelyne Schulz is a masterful digital painter of fantasy and fan art, which she somehow finds
time to create while working for an international publishing company and raising two children.
Here is her story.

So, Evelyne, how and when did you get started with your art?
Art has always been a part of my life. My mother is a very creative person, so she made sure that her

children always had the right tools and materials within reach. She showed interest and motivated us to
keep going.

Who or what influenced you the most to pursue this passion?
That’s not easy to answer. When I was little it was my mother. Later it was my eight years older brother,

who put a lot of effort into creating art. When I was fifteen, I went to a special school for art and music, so I
was surrounded by people that appreciated art.

Have you ever taken formal lessons or are you self-taught?
When I was a child, my older brother taught me a lot. Then I went to a school with a focus on art. After I

had children, I stopped creating art for a few years. Later, when I started drawing again, I took private
lessons to catch up with a few things. Basically, I don’t think lessons are necessary though. The most
important thing is to practice a lot, but it can be nice to get a few good tips from experts along the way.



Do you have any tips that you could pass along to our readers?
Always finish the picture you’re working on, even when you think it

will be horrible. You will learn much more, and, who knows, maybe the
end result won’t be horrible at all.

What type of work do you do and how is your art involved withit, if at all?
Unfortunately my main job doesn’t have much to do with art. I work

at an international company that produces books and all kinds of
printed matter, and I’m responsible for pretty much everything apart
from accounting and the production itself. Usually I only check, adjust,
and prepare the print files and look at the artwork other people have
created, but sometimes I get to do some layout, too. That’s as much
“art” as it can get. Even though I would love to have a more creative
job, it is too much of a risk at the moment, since I’m a single mom
responsible for two children. If I were alone, I would gladly move into a
tiny apartment and work on a creative career.

Please describe your creative process.
First, I need an idea. Every idea comes from something I've seen. I

get most of my ideas either on the way to work or coming back from
work (by bicycle), or while running. My ideas are pictures or scenes.
Later, I sit down and create rough sketches or plain color paintings to
catch the right parts of the idea. As soon as I have one that looks
promising, I change it and add some details and work out a concept
painting.

Unless I have the right ideas for a lot of details, and lots of time, I
set the concept as my desktop wallpaper at work. Having to look at
the picture again and again helps me to discover mistakes and get
ideas for details, or realize how I need to change the image to make it
look right. Then I just refine the picture and add details until it’s
finished.
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When I create a piece for a customer it’s different, of course, because the customer usually has very
specific ideas about what the picture has to look like.

What is your overall digital process?
Again, it was my older brother that made me try digital art. (I just realized that I should send him some

flowers. Writing all this has made me realize how much of an influence he had on me.) He had been
working digitally for quite a while, while I was still extremely skeptical of that process. I usually worked with
color pencils, sometimes combined with acrylic paint, and I couldn’t imagine drawing natural-looking things
on the computer. I kept myself from digital art, although I never really thought about it that much.
Whenever I came across an impressive piece of art, then read that it was digital, I found myself adding “ah,
but it’s only a digital piece” in my head.

One day I visited my brother (he lives in a different country, so that doesn’t happen too often) and he
showed me how he created digital art. I tried out his interactive display, which is basically a screen that can
be rotated and tilted, and you just draw on it with a special pen. I was impressed, because it felt so natural,
and the result looked amazing. A while later he acquired a new tablet, and I got to keep his old one. That’s
when I pretty much switched to digital art.

How did you come to use GIMP and / or other open source graphics tools?
My first computer ran Linux. My next few computers also ran only Linux, because I loved this operating

system very much. Back then I was developing text-based online role-playing games in a special form of
object-oriented C, and this was just so much easier on Linux. I liked working in the console instead of
fiddling around with the mouse.

At a certain point I needed to edit graphics, I think it was for the game’s home page, but I don’t quite
remember. I asked my older brother what program he used on K Desktop, and he recommended GIMP. It
was a bit unstable back then, but still a good choice. As time went on, GIMP just got better and better and I
never had a reason to switch, not even when I was working as a graphic designer later and had
participated in Adobe courses. Today I have legal copies of almost all of the Adobe programs, including
Photoshop, but I still use GIMP. (By the way, I’m not saying Photoshop is bad. It’s an excellent program,
too.)

g i m p m a g a z i n e . o r g | 3 7



g i m p m a g a z i n e . o r g | 3 8



What could the GIMP developers do to make GIMP a better tool for digital artists?
I think the brush dynamics could be improved. It’s hard to sketch in GIMP. It never looks quite natural if

you're trying to create a pencil sketch look. Also, when drawing “ink” outlines, it never feels as natural as in
other programs, like Paint Tool SAI for instance, even though I have spent hours trying out various settings.
So this is definitely something I would love to see – improved brush dynamics.

Where do you see your art going?
When I was a teenager I preferred a manga-like drawing style, although I stretched it a bit into a realistic

direction later. When I got older I lost my interest in manga and anime and my drawing style changed, too.
It became more realistic – I gave up drawing outlines. After my long break from creating art I continued
drawing realistic pictures, and when I discovered digital art I “polished” my pictures to an almost photo-
realistic quality, with tiny textures and details. I got tired of this technique though, because it required far
too much time to create those types of pictures, and people kept mistaking them for photos or photo
manipulations. That’s why my latest pictures are slightly less realistic, and I think I will probably continue
some more into this direction, away from the photo-realistic quality, into a slightly more artistic direction.

Which projects are you working on now that you would like to promote?
In December I made a “what to draw” poll on Tumblr, which resulted in a few interesting pictures. One of

them was a wizard fox riding a dinosaur, which was very popular. I’ve decided to create a poll like this every
three to four months, and no idea will be refused, no matter how crazy it sounds. The more people who
participate, the better of course, so I would like to encourage people to follow me on Tumblr or Twitter, or
track the “wizard fox” tag. Also, I’m still looking for a fantasy author to work with. I would love to create a
book which is a combination of a carefully worked out fantasy novel and a number of detailed, realistic
illustrations. The concept would be worked out together, so anyone interested is welcome to contact me
via my blog or my home page.

If you could go back in time, what advice would you give yourself?
I’m happy with my life and who I am today, so I wouldn’t give myself any advice at all. I made some

terrible decisions in my life when I was younger, and the right advice would have kept me and people
around me from a lot of pain and suffering. Still, all those problems, all the pain and seeing what life is like
when you’ve lost everything, has made me the person I am today – a better person.
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Where can your work be found?
You can find a few personal works and most of my fan art on my blog: eleathyra.tumblr.com (in the “My

Art” section)
My official home page: www.eleathyra.com
Twitter: @eleathyra

And a big part of my work can’t be found online because they’re commissioned pieces.■ ■
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details. You can also follow us on Twitter at
www.twitter.com/GIMPMagazine or on Google+ name GIMP
Magazine.
WANT TO JOIN THE GIMP MAGAZINE TEAM?

Have you researched stories, interviewed people, and
written articles? Are you a digital artist or photographer? Do
you have a passion for GIMP or related open source
software? Let us know by sending us an email with your
credentials and interest to http://gimpmagazine.org/contact.
INTERESTED IN ADVERTISING WITH US?

We are considering publishing corporate advertising in
upcoming issues. We are looking for organizations from the

following areas who are interested in reaching potentially
millions of interested GIMP users:
• Specialty computer hardware, printers, monitors, pen

tablets, etc.
• Specialty cameras, lenses, filters, lighting, accessories, etc.
• Specialty print and imaging services
• Stock photography, textures, font collections, etc.
• Artists, photographers, models, creatives, etc.
• Software / photography / graphic design courses,

conferences, etc.
• Specialty software filters, plugins, apps etc.
• Instructional books, DVDs, videos, etc.
Our Advertising Rate Card can be found at

http://gimpmagazine.org/about

SUBM ISS IONS
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